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Introduction: 

      To enjoy the program, please read this manual carefully.  BridgePro was developed with the
premise that the Windows® user could play the computer as realistically as if one were playing with
three other people.  I hope this goal has been achieved.  Do not be overwhelmed by the complexity of
the conventions available to you if you are not an advanced player.  One purpose of this game is that
the user, that’s you, can gradually add selected conventions at his or her discretion.  Reading bridge
books and pamphlets, reading and playing the daily newspaper bridge column and playing at a local
club will add to the excitement and entertainment offered by leisurely playing BridgePro. 

Installing BridgePro:

             MAKE A BACKUP COPY OF YOUR INSTALLER PROGRAM NOW! 
                                [If you did not purchase a CD from us.]

      You must be using Windows® 95 or greater.  Simply left click on the BridgePro Installer.exe icon.
This is a compressed file that will automatically place all your files in their correct location. Please
follow the Wizard’s directions carefully.

      BridgePro is newly scaled to play at any resolution.  You must use the highest color depth
available [True Color on older systems.].  On older machines, the play of the game will be slower than
on  newer  models.   Be  patient,  your  Computer  Partner  is  going  through  some  very  complex,
complicated algorithms to select the proper bid or card to play. Kindly leave the Windows® Task Bar at
the bottom of your screen monitor.  Remove or temporarily move any tool bars that are at the left or top
of your screen. Failure to do so will cause the cursor arrow to misinterpret its position.

Start Up:  

      When you boot up BridgePro for the very first time, an informational Dialog Box will be
presented to you.  You MUST enter at least three characters in the Name text box.  If you prefer, the
organization/address text box can be left blank.  You MUST enter your registration number correctly.
[If your registration number is not yet available, you may proceed by leaving the registration number
blank and clicking OK.  As soon as you receive your number enter it at the next available log in.]

      Upon entering all information correctly, the mandatory copyright data is presented, and then your
name, and organization/address.  The game will then begin.  You will NOT ever need to enter this
information again unless you reinstall the game. Then it is imperative that you have your registration
number.  PLEASE safely store this number.  It cannot be replaced at a later time nor can the original
copy of your game installer.

      On subsequent start-ups, only the copyright data and your previously entered data will be displayed
prior to the game commencement.

       If you receive a warning on booting up the game that your DPI is not set to the normal value of 96
go to the Control panel.  Select Display and then click on the Settings tab. Click on the Advanced
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button and then set the DPI to 96 [normal].

Registration Number  :

      Your registration number is unique.  You have the ONLY copy of this number.  Secure this number
in a safe place.  It will be required if support service is needed, or you reinstall your game onto a new
computer or you re-initialized hard disk. [There are no letters “O” or “L” in the registration number to
avoid confusion with numbers “one” and “zero.”]

What’s New  :  
       The following changes have been made in version 3.1.x:

1.  Menu selection to immediately replay previous board even though new board has already 
been dealt [User forgot to save previous board].

2.  Better partial game strategies have been added.
3.  Various additions to the Option Menu allow more choices in selection of card play attributes,

warning alerts and bidding options.
4.  Significantly improved bidding and card play.
5.  The game will now play at any resolution.
6.  The graphic interface has been significantly revised and improved.

            7.   A new and improved Installer [with helpful Wizard].
            8.  The game will now play Windows 8 and any version below.

General     Play:
It is recommended that you do no other tasks while playing the game.  If you must do other

work [check emails, type a letter, etc.] it is best to save the hand you are playing and formally close the
game using the Exit command in the File Menu.
The game is designed to play like real people.  If you do not set your menu Level to Advanced, your
computer partner will make many more mistakes.  The best way to play is with the Level at Advanced.
Then individually select the Conventions you wish to play.

Default Settings:

       The initial level is Advanced.  The conventions are set to mimic SAYC (Standard American
Yellow Card).      This  is  the  American  Contract  Bridge  League’s  recommended  conventions  for
standard play at duplicate bridge tournaments.  If you intend to play Acol, you must immediately go to
the Convention dialog box and affect the change.  The default speed is set at the game's slowest play.  
After you have played the game for a while and pick up the rhythm of bidding and card play, un-check
"Warning Beep" in Options under the Special Features menu.  This will speed up play considerably.
Also, un-check "Allow Animation" in Options under the Special Features menu will improve the speed
of the game.  Un-check "Sound" in Options under the Special Features menu will have a small effect on
some machines.  "Fast Play" in Options under the Special Features menu should always be checked
(default setting). Un-check "Highlight Card" will further reduce the number of clicks necessary to play
a card. C  hecking   "Quick Bid” will eliminate the need to press Enter after each bid.
    The fastest way to speed up the bidding is to use the keypad to enter your bid.  You can use the
keypad and/or the visual bidding (mouse click) at the same time.  By un-checking "Visual Bidding" in
Options under the Special Features menu, you will be forced to use the keypad as the visual bid buttons
disappear and are replaced by card backs. Look at page 6 to learn which keys control the bidding.
    Finally, if you don't need the Alerts flashing, you can selectively disable them by going to the Special
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Features menu and choosing Convention Alerts.  You will then be presented with a series of dialog
boxes that will allow you to deactivate specific Alerts. 

Blackwood/Gerber Slam Bidding Convention:

        The Blackwood Slam Bidding convention  is the default setting.  You may change to the Gerber
convention by selecting the proper button. You may elect to use Roman Key Card.  This will be used
with  both  Blackwood and  Gerber.   In  the  Advanced  level,  the  Malowan  Six  Club  Convention  is
employed. See: The Menu -> Special Features -> Conventions.

Strong Opening /Weak Opening Two-Bids:

        The Weak Two-bid opening   is the default setting. When playing this setting, the Two-Club
Forcing Bid is automatically supported. Here a hand of 23 high card points (HCP) or better is required.
If less points, then 3 or less losers are needed. A response of 2 NT indicates a hand with 8 HCP and no
5 card suits. The only sequence that can be passed is 2c, 2d, 2NT.    To select a Strong two-bid opening

go to The Menu -> Special Features -> Conventions. 

           If a Strong Opening Two-Bid is selected, then a response of 2 NT (indicating 0 to 7 points)
followed by the opening bidder bidding 3 of his original suit allows the responder to pass; an escape
clause for worthless hands.

Two Club Forcing Bid:
           See above.                                    . 

Two     Club     Forcing     Bid     Response:  

           The first response of the Two-Club Forcing: 
                       2d -------  0 - 7 HCP 
                       2h, 2s, 2NT  ----- 8 HCP & above. An Ace + a King or an Ace-Queen suit is acceptable.

     A 2NT response indicates no 5 card suits is present and 8 HCPs or above.

     If the Opener bids 2NT after a 2d response, this is the only sequence that can be passed out (2c, 
2d, 2NT,p).

          Double Negative: If the responder has bid 2d and the opener has bid his suit, the second response
of 2NT indicates a hand with less than 4 HCPs (2c, 2d, 2s, 2NT). 

Options:
      

Tricks:
           The default setting is for this feature to be active.  This will allow a tally to be continuously
updated of those tricks won and lost.  It also activates a small V in a circle to indicate which side is
vulnerable.  This icon will appear on the Score menu bar as well as the main screen.

           On the main screen, the V icon, , will appear at the left of the screen near the South
marker when the North-South partnership is vulnerable.  The V icon will appear at the right side
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of the screen near the West playing position marker when the East-West partnership is vulnerable.
(see p. 16.)

      

   Sound:

       The default setting is for this feature to be activated.  Various sounds accompany the progress
of the game.

      Warning Beep:
             
       The default setting is for this feature to be active.  It is recommended that you use this in your
first few hours playing the game.  It is simply a reminder that it is your turn to input something.
Though there are visual prompts to advise you of your responsibility, I have found this helps to
improve  familiarity  with  the  rhythm of  the  game  initially.   Later  on,  you  should  choose  to
deactivate this feature, as play will be faster and smoother.

Levels:  
       The following bidding and playing conventions are supported in:
                 [If playing Acol convention see pp. 10,17-18]
                Advanced:.
                     Cue Bidding (Enemy’s suit and/or Aces).      .
                     Blackwood/Gerber Slam Conventions.
                     Roman Key Card Blackwood/Gerber.         .
                     Strong/Weak Opening (two club Forced Bid).
                     Takeout and Penalty Doubling and Redoubling.
                     Weak or Intermediate Jump Overcalls.       .
                     Reverse Drury Convention.                 .
                     No-trump Bids with Stayman Convention
                            (option: 15 – 17 or 16 – 18 or 12 – 14 HCPs) .
                     Two-Over-One response
                                (NOT forcing to game unless Forcing NT selected).
                     Michaels Cue Bids (option: Top & Bottom Cue Bid).
                     New Minor Forcing Convention.                .
                     Splinter Bids.                        .
                     Response Doubles.                    .
                     Transfer Bidding (option: Majors Only).       .
                     Weak or Long [help] Game Suit Try.            .
                      2 NT Truscott [Jordan] Response To Opponent’s Takeout Double.               
                     DOPI
                     1 NT Forcing Response.                        .
                     Jacoby 2 NT Response.                                . 
                     Jump Bids.          
                     Jump Shift Bids.
                     Three to Five Preemptive Bids and Overcalls.
                      Reverse Bidding.
                      Lightner doubles.
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                      Limit Raises.                    .
                      Minor Bid Openings.
                      Forced Bids.
                      Reevaluation of hands for point counts.
                      Finessing.
                      Double Finessing.
                      Triple Finessing.
                      Ducking.
                      Card Counting.
                      Signaling.
                      Reverse Signaling.                    .
                      Triple raising.
                      Negative Doubling (Below 2NT).           .
                      Support Doubles.                    . 
                      Kaplan’s Inverted Minor Raises.          .
                      Malowan Six Club Convention.              .
                      Options     for     multiple     types     of     defense     to     1     NT     Openings:
                                    Astro
                                    Becker
                                    Brozel
                                    Cappelletti (Hamilton).             .
                                    D.O.N.T.
                                    Landry
                                    Natural
                                    Ripstra
                                    Transfers
                     Lebensohl Countermeasures (includes Weak 2 Bids).                   .
                    Gambling 3NT Opening & Overcalls.                .
                    5NT Grand Slam Force (Josephine).         .
                    Unusual 2NT Overcall (option: minors only)

                 Intermediate: 

                      All techniques listed in the Advanced phase EXCEPT:
                        Cue Bidding.
                        Weak Opening and Two Club Force Bids.
                        Reverse Drury Convention.                 .
                        Card Counting is not as vigorous.
                        Signaling (Limited).
                        Lebensohl Countermeasures.         .
                        Gambling 3NT Opening & Overcalls.      .                          
                        5NT Grand Slam Force (Josephine).         .
                        Unusual 2NT Overcall .                    .
                        Michaels Cue Bids                 ..
                        Splinter Bids.                        .
                        Response Doubles.                    .
                        Transfer Bidding                    .  
                        Malowan Six Club Convention.              . 
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                        Support Doubles.                .
                        Roman Key Card Blackwood/Gerber.           .
                        Limit Raises.                    .
                        Only Natural Defense to 1NT openings        

Basic:

 Only the very basic bidding and playing techniques are supported.
                       Stayman Convention is excluded.
                       No finessing.
                       No card counting.
                       Minimal signaling (MUD supported). 
                                            (see p. 8.)

The Play:   

  The Deal:

Each deal is totally random.  Therefore, playing the same hand over would be virtually impossible
except for the fact that six different hands can be saved for replay at a later time.  During a particular
board you can elect to Re-bid the board or Replay the cards without saving the hand.  You must saved
the hand before going on to the next board.  A New Game or a New Rubber can be called for at any
time during play.

   Saving: 

            See The Menu -> File -> Save Hand 
   

Replaying Saved Hands:
See The Menu -> BridgePro -> RePlay Saved Hand. 

   Initial Bidding: 

           

You will receive a visual and auditory request for input.  

Using     the     Keyboard  :   
 

          

       E.g.,to bid two spades: press the ‘2’ key followed by the ‘s’ key followed by Enter or Return key.
                                     Pass             ->     ‘p’
                                     spade           ->     ‘s’
                                     heart            ->     ‘h’ 
                                     diamond      ->     ‘d’
                                     club             ->     ‘c’ 
                                     no-trump     ->      ‘t’ 
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*** You must press Enter or Return key to finalize your bid. The Enter or Return key need be pressed 
only once during your input, and NOT after each character is pressed.  If you mistakenly enter a 
character, simply re-enter it without penalty.  ‘Pass’ is the exception.  When the character ‘p’ is entered, 
no other entry can be made.  If you wish to bid differently, you must ReBid Hand.

Using     the     Keypad: 
            

The keypad maybe used to enter any of the numbers. Suits are then enter ‘0’ is for no-trump; ‘1’ is for 
spades; ‘2’ is for hearts; ‘3’ is for diamonds; ‘4’ is for clubs.

‘Pass’ can be effectuated by pressing ‘0’ on the keypad as the first entered character (Note: when ‘0’ is 
entered after a numeral is first entered, the meaning is no-trump).

An asterisk (*) will enter a double or redouble.

Using the keypad is the fastest way to enter your bids!
You must press Enter or Return key to finalize your bid. This is the default setting.  If you choose 
Quick Bid in the Options menu, bidding is speeded up and this step is bypassed.

        Subsequent Bids: 

            Instruction will follow each bid.  Follow the screen prompts.  Appropriate warnings will be 
rendered if inappropriate responses are obtained.

      

  Re-bid Current Hand 

      If at any time you wish to re-bid the hand, go to The Menu -> Special Features -> ReBid Hand 
or use Ctr + R.

       Reneges, Revokes:

            If a misplay occurs, a Dialog Box will appear instructing the user to make the appropriate 
choice.

Playing the Cards: 

     Once bidding is completed, the Dummy and lead card will be appropriately exposed.

Using the Mouse:

      When instructed by the screen prompts, pointing the Mouse and clicking the left Mouse Button will
automatically  cause  the  selected  card  to  be  transferred  to  the  Discard  Pile.   There  are  auditory
reminders and, finally, Dialog Box instructions if proper selections have not been executed.

Replay Current Cards:

      At any time during the play, the cards may be replayed without re bidding by selecting Ctr + A.  Or
see: The Menu -> Special Features -> Replay Cards.

Changing Positions:       
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          You may play either partnership.  That is, by selecting Ctr + H you will switch North-South
partnership to the East-West hands.  Additionally, once this reversal has been effectuated, the Flip Hand
selection is enabled so that you can now play your partner’s hand if you so wish (Ctr + F).   See:  The
Menu -> Special Features -> Reverse Hands or Flip Positions. (see p. 15).

If you plan on doing several reversals and flips it is best to save the hand first, as on some machines
repeated switching leads to the need for re booting.

Revokes:                     

         If you misplay a card, it will automatically be placed in the Penalty Pile.  You must then play the 
correct card.  Thereafter, at the first legal opportunity, the Penalty Pile must be vacated.  Appropriate 
Dialog Box prompts will help you.

         BridgePro does NOT support more than one card in the Penalty Pile.  If more than one is
present, you will be given the opportunity to replay the game and execute more careful choices.  You
may elect to deactivate this feature [Uncheck it in the Option menu.].

Doubling:  
You can double at any time during the bidding by pressing Alt + D then Enter or Return or the multiply 
key on the keypad (*).

Redoubling:   
You can redouble at any time during the bidding by pressing Alt + D then Enter or Return or the
multiply key on the keypad (*).  Redoubling will occur if a double has already been bid.

Signaling:            
           
           During play,  MUD is supported.  E.g.,  Middle-Up-Down when leading from three cards
with no honor card.

Doubleton leads will be high followed by low.
          When you are void, leading high in the sluff suit indicates your partner is asked to play an
appropriately higher suit lead at his next opportunity.  Conversely, playing a low card asks your partner
to play an appropriately lower suit at his next lead.

Viewing All Hands:  

       If at any time you wish to view the hands as originally dealt then pressing Ctr + P.  This will show
the North-South partnership hands.  Pressing Ctr + O will allow viewing of the East-West partnership
hands.   See:  The Menu -> BridgePro -> Opponents’ Hands or Partner’s Hand.

The Scoring:  

   Getting the Score:

         The scoring window is available at all times.  The default selection is standard rubber bridge.
However, there are options to select Chicago style scoring or its variation of New York style scoring.
[See Special Features Menu.]
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Review     Tricks     Played  :
          Pressing the F1 key will bring up a window that shows a recap of the cards played.  A small
green asterisk denotes the winner of the trick.  After a hand is scored, this window will continue to
show the previous played hand until the new bidding is completed.

        Current Score:

         Press Ctr + T (or See: The Menu -> Special Features ->  Score -> Current Score). This shows the 
current score of the rubber in real time.

      Cumulative Score:

              (See: The Menu -> Special Features -> Score -> Cumulative Score). This keeps track of the 
total rubbers won by you and THEM (that’s your computer buddy opponents).  

End of Game:

           At the end of each game, a special Dialog Box will present itself along with the Score Window.
Choices will  be available to either continue onto a new game, re bid or replay the cards from the
previous hand.  You may also Exit the game at this time.

Rubber:

           At the end of each rubber, a special Dialog Box will present itself along with the Score
Window.  Choices will be available to either continue onto a new rubber, re bid or replay the cards from
the previous hand.  You may also Exit the game at this time.

Honors:
                       Honors will be posted at the end of each game.
                       Four honors -> 100 points.
                       Five honors -> 150 points. 
                       Four Aces at no-trump  ->150 points

      Vulnerability & Doubling:
                                   
                                          N  ot Vul.              Vulnerable
                                       Undbl     Dbl        Undbl        Dbl
            1st  undertrick       50        100         100          200     
all other undertricks         50        200         100          300.    .      
                  (after the third trick Dbl gets 300 if not vul.)                                                               
        Overtricks:                Not Vul.                Vulnerable
             UnDoubled           trick value               trick value
             Doubled, each          100                           200
             Redbl, each               200                           400
             Little Slam                  500                           750
             Grand Slam             1000                         1500  
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Other Scorings:  
        50 points will be awarded for making a double or a redouble.                            .                     
        500 points for winning 2 out of three games.

        700 points for winning the first two games consecutively.  

Rules To Play By:  

Opening Bid Requirements:
           Though your computer buddy will not stray from the prescribed point count, defensive trick,
biddable suit and re-biddable suit requirements, you, the User, may.  Beware, however, the responses
may not be those you would wish!  In the Advanced level, HiLeQT [Highly Cute] point count is used.
This is similar to Bergen’s points with the additional requirement that defensive trick count is added.
Thus,  22  HiLeQT  points  are  needed  to  open  in  the  first  or  second  position  [21,  if  favorable
vulnerability exists]. In the Intermediate level, Bergen’s Points are used to determine if an opening bid
can be made in the first or second positon. The hand will be opened if the HCP + the two longest suits
>= 20.  One and one-half defensive tricks are needed if a 5-5 or better distribution is not present.

          Your partner will ALWAYS pass your opening suit bid if he has less than 6 points.

           Your partner will ALWAYS bid if he has 6 or more points to your opening suit bid.

           At the level of 2, your partner will NEVER bid in a new suit without a minimum of 10 points.

13 Point Hands:

          At the Basic and Intermediate levels: To open with 13 points, the hand must have at least 2
defensive tricks (Quick tricks) AND a re-biddable suit or two biddable suits.

       In the third and fourth position, bids with less than 13 points are sometimes made.  Pearson’s
Points (The Rule of 15) are used to calculate an opening hand in the fourth position (HCP + total
number of spades >=15).

14 Point Hands:
          At the Basic and Intermediate levels: Though called a ‘Mandatory Bid’, 14 points will not secure
a bid unless 2 defensive tricks (Quick tricks) are present or there are 14 points in high cards only.

5 Card Major Requirement [Non-Acol]:
        There is a requirement that there be five cards to open in a major suit has an exception.  AKQJ 
four card suits in the majors will be opened.

Acol Bidding:
       Four card suits bid up the line.  Weak no-trump when not vulnerable and strong no-trump when
vulnerable.  The default is 12-14 HCPs for weak no-trump and 15-17 HCPs for strong no-trump.  Acol
Two-bid is forcing for one round.  2NT opening indicates 20-22 HCP, balanced.  23 HCPs will get a 2C
bid [2D if Benjamin convention selected (see p 23).].
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No Trump Openings:

        Standard No-trump openings are supported.  Appropriate stoppers and balanced hand 
requirements are mandatory.

        If you are playing at the advanced or intermediate levels then a choice between point spread of 12-
14 points, 15 - 17 points or 16 - 18 HCP is available.  At the Advanced level, the 3 NT bid is always 
interpreted as a Gambling 3NT convention.

No Trump Response after Suit Bid:

         If Forcing 1 NT response is utilized then [not Acol]:

                                                   2 NT = 11 or 12 HCPs and is NOT forcing.

                                                   3 NT = 13 to 15 HCPs.

          If Acol bidding is utilized:

                                                   2 NT = 11 or 12 HCP and is NOT forcing.

                                                   3 NT = 13 to 18 HCPs

           Otherwise a convention approach is:

                                                   2 NT = 13 to 15 HCPs and IS a game force.

                                                   3 NT = 16 to 18 HCPs.

A Two Club Forcing:

      The opening will be expected with a balanced hand with 23 HCPs or 3 losers or less.  It can be 
made with any hand similar to a strong two of a suit opening. (see p. 3)

Stayman Convention:
The 2 and 3 club convention is supported. Stayman is non-forcing

The Special Minor Bid:

       If you cannot open using the standard criteria, you may open one diamond or one club if you have
a 3-card suit headed by at least a queen and your standard opening has no re biddable suit.

Preemptive Bids:
       Preempt bidding will occur if no more than 15HCP in a major suit is present are present and
usually 6 - 10 without a side 4-card major.  The ‘rule of two and three’ is used to establish these bids.  A
seven-card suit is expected.

Two-Over-One Bid:
     If  the Forcing  1 NT Response preference  is  utilized,  then this  sequence is  forcing  to  game,
otherwise it is not a force to game.
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The Menu  :

 

     File Menu: 
   Save Hand:                            

   

          A Dialog Box will  appear.   You may choose a place to save the current hand from six
different buttons.  You may name each hand.  E.g.,‘Grand Slam No-trump Hand.’  The name will also b
e saved.  
         If you wish to change only the name of the hand without changing the hand, you MUST select the
appropriate radio button FIRST, then re-enter the appropriate wording and press Cancel. (changing the

text alone, without selecting the proper radio button will not save your text changes.) 

   Print Current Hand: If your printer is connected and working, you may print the current hands.  
   Print Trick Review: If your printer is connected and working, you may print the trick view panel in
real time or after a board is completed.
   Print Previous Board: If your printer is connected and working, you may print the previous board 
once the first board is scored.
   Exit:
            This feature is always enabled.  It allows you to Exit the game at anytime.  The Cumulative
Score window will appear before the final shutdown. You may use Alt + X key to activate a quick Exit
or press the Esc key.
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 Edit     Menu  :   
       This feature is disabled during bidding.  When card play is ongoing, the first selection in this menu 
will allow an Undo of the previous card played or if the first card, then the previous trick.  You may 
still elect to replay the entire hand by selection of either Rebid Hand or Replay Cards. 

The Play  : 

    

New Hand:
        This feature is enabled at all times when the main screen is active.  It allows you to immediately
start a new hand.  You cannot retrieve an old hand unless you have called Save Hand prior to calling
this feature.  (Ctr + N). 

 Replay Saved Hand:                                                       .  
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        Present you with a Dialog Box that allows selection of any of the six previously save hands for
replay.  NO changes in text are saved from this menu selection. If you wish to change the wording of a
selection, go to Save Hand under the File Menu, press the proper radio button, change the wording and
select “Cancel.”  [ see p. 11]. The caption is then changed without altering the cards saved in that
position.

Force Lead Card:
       This will bring up a dialog box if you own our companion tool, CardStuffer™.

You may enter any card in the declarer’s left hand opponent’s hand. 
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Opponents’ Hands:

                Is always enabled when the main screen is active.  Allows viewing of the opponents’ 
original full thirteen card hands.  (Ctr + O)

Partner’s Hand:

                Is always enabled when the main screen is active.  Allows viewing of the your original full 
thirteen card hand and your partner’s.  (Ctr + P)                 

Current EW Hand:

                Is enabled only after the first trick is completed.  You can see both East and West hands as
they currently appear.  I.e., if it is the third trick, then the current 10 cards still remaining in the hand
that have not yet been discarded will appear. (Ctr + E) 

       Current NS Hand:
               Is enabled only after the first trick is completed and when you are playing defense.  You
can see both yours and your partner’s hands as they currently appear.  I.e., if it is the third trick,

then the current 10 cards still remaining in the hand that have not yet been discarded will appear.
(Ctr + S). If North or South is the dummy, this menu item is disabled since the player can already
view both current North and South hands.  
 

       Review Bids:   

           Is always enabled.  A moveable window will appear that will recap the bidding. (Ctr + B) 

       Last Trick:

Is enabled after the first trick is completed.  This screen view shows the last 4 cards 
played. (Ctr + L)  You must press the left mouse button is exit this screen.

        Review Tricks:

              Presents a window that recaps the play of the cards in real time or if selected during bidding,
will show the card play from the previous board.  A green asterisk denotes the winner of the trick.  If
ALT key and Print Screen keys are pressed simultaneously when this is the active window, the data can
be printed out for analysis.
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Previous Board:
              Presents a window with the bidding in the previous board.  You may then print this out by 
using the appropriate item in the File menu.
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Replay Previous Board:
   If the user forgets to save a board and a new board is dealt, the user can recover the previous 
board even though it had not been save using the File menu item Save Hand.

Special Features:
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ReBid Hand:

                     Is always enabled when the main screen is active.  Will reset the game so that bidding 
may begin again with the current hand.  (Ctr + R)

RePlay Cards:

                     Is enabled only when the main screen is active and bidding has already been completed.  
Will reset the game so that play may begin again with the current hand.  It will bypass the bidding 
routine.   (Ctr + A)

     Reverse Hands:     

                    Is always enabled when the main screen is active.  Will reset the game so that the hands
are now reversed.  I.e., North-South partnership will become East-West.  A Check Mark will indicate
that this feature is active. 

Flip Positions:  
                   
                    Is only enabled when the main screen is active.  Will reset the game so that the hands are
now reversed and ‘flipped’.  I.e., North-South partnership will become East-West and North is now
South; East is now West.   A Check Mark will indicate that this feature is active.  

If you wish to Reverse and Flip the card positions simultaneously, press Alt + F.

Score:  
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         Choose Scoring Method…:
               This will present a check menu with options for the default standard rubber 
scoring or Chicago type scoring [also available is New York type vulnerability.].

Rubber:  
Standard WE and THEY score with 2 consecutive game wins 

constituting a rubber or 3 total games. 
Chicago  :

A rubber consists of 4 deals. No one is vulnerable for first deal. For 
second and third deals, dealer is vulnerable and the other side is not.  Both sides are 
vulnerable at the fourth deal.  Part scores are combined.  If a part score occurs at the last 
deal, then that side receives a premium of 100 points to complete the rubber.

New York   variation:
The vulnerability of the second and third hands is reversed.  This gives

the non-vulnerable side an opportunity to preempt as dealer.

         Current Score:          
              
                Can be activated at any time during play.  If your RAM is small, it is best to completely close
this window after finishing with it, rather than sending it into the background.  (Ctl Key + T)

        Cumulative Score:

                Presents a Dialog Box with the current number of rubbers won and lost as well as the

cumulative rubbers won and lost for all session of the BridgePro game.  

Options:
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          Tricks:                                

        A Check Mark will indicate that this feature is active. 

            The  as shown above represents vulnerability for the East-West partnership.  If Tricks is 
disabled, this icon will not appear, nor will the tricks won and lost appear.

  
 Sound: 
 A Check Mark will indicate that this feature is active. Various sounds have been selected for the 
BridgePro game.  By disabling this menu selection, none will be played.

         Cursor Alert:
If unchecked, the warning dialog box that alerts you to incorrect positioning of your cursor will 

no longer appear.

         Highlight Card:
If uncheck, the card will be played to the discard pile with only one left mouse click instead of 
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being highlighted in yellow and requiring a second click to move the card to the discard pile.

   Warning Beep:
     The game sounds a warning when it is your turn to input a bid or select a card..
     A Check Mark will indicate that this feature is active. If you want the game to play faster, 
uncheck this option!

    Visual Bidding:
       This is set as the default.  You simply point your mouse at the appropriate bid area, click the
left mouse button and the bid will execute.  If this option is left unchecked then the Visual Bidding
Frame is change to a reverse deck of cards.  You then must use either the keyboard or keypad to
enter your bids.  Both the keyboard and keypad are active even if this option is selected.  Bidding
from the keyboard and keypad is the fastest way to execute your bid (see p. 6).  

    

OR

                  
 

  Allow Animation:
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      This is the default setting.  If this is unchecked, animation of the card movement during card 
play will cease.

  Disable Revoke:
      This is unchecked as the default setting.  If this is checked, revokes will not occur (See p. 7). 
Instead, you will not be able to play the card chosen.

   Fast Play:

      This is the default setting.  If this is unchecked, then the play stops after each individual bid or
each individual card is discarded.  The deactivated mode may be helpful when analyzing the play of
a particular hand.

    Show HCPs:
The default is checked.  This will show the high card point count of the south hand on the 

initial screen.  Also, the point count will be visible for all hands when Opponents’ Hand or Partner’s
Hand is selected from The Play menu.

Quick Bid:

    The default is NOT active.  You must click Enter or press Enter on the keyboard after each bid.  The 
Visual Bid graphic will look like this:

     If you check this option, you will not need to press or click Enter after each bid. This speeds up play.
The button will look like this if this option is checked.
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Dummy     Cursor     Correction:
   On some monitors, the screen resolution and/or DPI cause abnormal interpretation of mouse 
clicks in the dummy cards.  If you are experiencing difficulty clicking the proper card in the 
dummy try checking this option.

Conventions:
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    Your may set individual conventions for you and your partner [use Conventions] and a different set
of conventions for the enemy [use Enemy Conventions…].

       Choose first :  whether you will play 5 Card Majors [Standard American] or Acol.  Then choose
Blackwood and Gerber Slam Conventions [RKC can be selected for either (Roman Key Card)], and

selection of a Weak or a Strong Two-Bid Suit Openings.

The default selections are shown above.  Note the Enemy’s Convention is marked with a bright red
label.  If you do not see this label, then it is your conventions that are to be set.

Acol players can elect to play Benjamin Two [A 2 D bid is the equivalent of a 2 C Acol bid.
Opening bids of 2H and 2S are weak.  A 2C bid shows a one-round forcing two bid and promises at
least  8 tricks in an unspecified suit.  The sequence 2D-2H-2NT shows 23-24 HCPs and can be
passed.]  or Herbert Negatives [The cheapest bid suit is a negative response to an opening bid of 2].

      If Weak Two-Bid is selected, then the Two-Club Force Opening is automatically supported.  (See 

Rules To Play By -> No-trump Openings;  *** IMPORTANT ***    See Two-Club Forcing Bid 
Response under Default Settings - p 3.).

               Weak     NoTrump     Opening     (12     –     14     HCP):
       If the opener’s weak no-trump is doubled, one uses 2D as a request for the opener’s better major.
A redouble is  a request for the better  minor.   This is  the escape method to avoid playing at  1NT
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doubled.

     Reverse Drury  :  

       A conventional 2-club response by a passed hand after partner’s major opening. [p,1s,2c]. The 2-
club bid asks the opener to clarify his strength. If the opener rebids his suit, this is a weak response.  All
other bids by the opener are strong.

   

         Inverted     Minor     Suit     Raise: 
         This is a special response to a minor suit opening by your partner.  If you have 10 points or
less (include distribution) and support (4 or more of the opener’s bid), you respond with a jump to
three of the minor suit.  This is a weak shut out bid.
         If, with the same hand, you have support and 10 points or more, then you respond with a two-bid
of the opener’s suit.  This is a strong bid forcing for one more round.

  
   Limit Raises  :  
        A jump raise [1h,3h] in a major suit indicates 4-card support and approximately 11 HCP or
distributional points. Only 3-card support is needed after interference [1h,(2d),3h].

   Michaels CueBid  :
       The immediate cue bid in the opponent’s suit shows a two-suiter hand.  Classically, a minor
suit opening by the opponent indicates you have both majors. If the opponent opens a major suit,
then your bid indicates the other major plus an undetermined minor suit. The major suit cue bid is
unlimited in its point count.  With unfavorable vulnerability, freakish distribution is needed.  If
the ‘Top & Bottom’ box is selected, then a 2h or 2d bid would indicate the two-suiter to be spades
and clubs with a longer stronger minor suit. Likewise, 2s bid indicates hearts and clubs, while a
2c bid indicates spades and diamonds with the longer stronger suit being the minor.   In general,

the point range is 6 - 11 HCPs with at least 9 cards between the two-suiter (5 - 4 hand minimum).

Your computer buddy will bid only if he has five honors or better between the two suits.
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 Negative Doubles  :
       If checked, the convention will be followed with bids equal to and below two spades. A minimum 
of 6 HCPs is necessary. This convention applies to suit openings only.  The negative double caters to 
unbid major suits.  It promises 4 cards in any unbid major.

   New     Minor     Forcing  :
       After the opener’s rebid of  1 NT a bid of the unbid minor suit is forcing the opener to bid again. 
The responder should have 9+ points.  He is trying to establish a five-three fit.  If the responder makes 
another minor suit bid at the 3 level, it is again forcing.

        Opener’s Rebid:

               2 level major -> minimum hand with 3 card support
               3 level major -> maximum hand with 3 card support
               2 NT -> maximum hand with 2 card support
               2 d -> 5+ diamonds (strength not indicated)
       Kindly refer to the reference material as this bidding is too complicated for discussion here. 
Hardy’s proposal for response was utilized, but not the Hardy or Witts adjunct.

   Reverse     Signals     [Upside-Down     Signals  ]:  

         A low card in defense is used to encourage a continuation of a suit or a shift of suits.  A high 
card is a discouraging signal.
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 Splinter     Bidding  : 
         An unusual jump guarantees a fit for your partner’s last bid suit as well as game values with
either a singleton or void in the suit bid. Splinters are used in both major and minor suits. Think
of splinter bidding as a small slam try.[1s,4c]

  Support     Doubles  :

 A convention used by the opening bidder upon his rebid after the right hand opponent has 
overcalled.  This double indicates 3-card support for the responder’s major suit.  If the open 
passes, he must alert as this indicates less the 3-card support. 
 Transfer Bidding:

          After a 1 or 2 level NT opening, the following responses are:
                              2d -> transfer to 2h
                              2h -> transfer to 2s
                              2s -> transfer to 3c
                              2nt -> transfer to 3d
                              3c is natural and a slam-going one suiter. If you have a quantitative 2nt raise, 
then bid 2c.  This does not guarantee the responder has a major.  He maybe is trying to reach 2nt.  
Therefore, some individuals use transfers in the majors only. [option check box: ‘majors only’]
         The transfer guarantees five or more cards in the next suit up the line.  No strength is indicated.

   Weak     or     Long     [help]     Game     Suit     Try:
         This is a change of suit after a major suit has been raised to the 2-level.  It does not matter if it is 
the opener or responder who makes the change of suit. [1h,2h,3c] or [1c,1h,2h,3d].  The trial bid 
promises 3+ cards in the trial suit and asks for help in the trial suit. The standard responses are:
                              1 loser or none in the trial suit -> bid game in the agreed major suit.
                              2 losers in the trial suit -> bid game if you have a maximum, but sign off in 3-of-
your-major suit if you have a minimum.
                              3 losers in the trial suit -> sign off in 3-of-your-major suit.

    One     1     NT     Forcing     Response:
        This shows a hand with a good 5 to a bad twelve points after your partner opened a major suit at 
the one level. When the responder is not a passed hand, it is forcing for one round.
    2NT     Jacoby     Forcing     Response  :
        A jump to 2 NT after a major suit opening by partner guarantees 4-card support for the opener’s 
suit and game going value.  The responder wishes to take charge of the bidding.  The opener’s 

responses are too complicated to outline here.  Further outside reading is indicated.

    2NT     Truscott     [Jordan  ]     Response     To     Opponent’s     Takeout     Double:
        Instead of a redouble which is standard in the American system after a takeout double by the 
opponents, this convention is an artificial strong raise with 10+ HCP and 4-card support for your 
partner’s opening suit.
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Pinpoint Astro  :
        2 Clubs  = Hearts and clubs ; 2 Diamonds = Hearts and diamonds; 2 Hearts = Hearts and 
spades; 2 Spades = Spades and a minor;  2 NT = Both minors.

Becker  :
       2c = Both minors
       2d = Both majors
       others = one suiters
 

 Brozel  :
         Double show any one suiter worth a bid at the 2-level. Jumps to the 3-level   
show strong three
 suiters, 4-4-4-1 or 5-4-4-0.
         2c = Hearts and clubs
         2d = Spades and diamonds
         2h = Hearts and spades
         2s = Spades and a minor
         2nt = the minors
    Cappelletti     [Hamilton  ,     Pottage  ]:
         2h or 2s = that suit + a minor
         2d = Both majors
         2c = One suited hand
         2s = Spades and a minor
         3-level = Natural
         All the hands usually have less than 15 HCP

        D.O.N.T  :

              2h= That suit + spades
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              2d = Diamonds and a major
              2c = Clubs and another suit
              2s = Natural
              Double = One-suiter [usually not spades]
        Landy  :
              2c = both majors
              other actions at the 2-level show one-suiters
        Ripstra  :
              2c = Both majors with clubs longer than diamonds
              2d = Both majors with diamonds longer than clubs
        Transfers     over     1     NT  :
              2h -> spades
              2d -> 2h
              2c = Puppet to 2d
              2s -> 3c

        Lebensohl  :
              This is an artificial bid of 2nt.  It is a forcing bid indicating you hold a stopper in the 
opponent’s suit. It cannot be used against a Cappelletti defense. If Cappelletti is used, then a double is 
used as Stayman.  This convention requires that the opener bid 3c.  The Lebensohl caller then clarifies 
his hand.

Convention     Alerts  :
           This series of dialog boxes allows the user to prevent an alert from appearing. It speeds up 
play.  There are a few alerts not listed above.  Among these are:
           5 NT Grand Slam Force   [Josephine  ]: a 5NT bid when not natural or used for some other 
convention ask the partner to bid to the 7-level of the agreed suit if he has 2 of the top 3 honors.  
Otherwise, he signs off at the 6-level.  This is the classic description, but BridgePro will, at the 
Advanced level expect a reply of: 6c/6d/6h/6c to show 0/1/2/3 top trump.

           Maximal Overcall Double  : This bid represents an artificial game try.  It occurs after a specific 
competitive bidding sequence:
                                    1S,(2H),2S,(3H),Db
                                    1H,(2D),2H.,(3D),Db
                                    1S,(Db),2S,(3H),Db
                                    1C,(P),1S,(2H),2S,(3H),Db
                                    1C,(P),1H,(2D),2H,(3D),Db
      If the bidder had instead of doubling, bid the agreed suit, this would be a sign-off  at the 3-level.

           Malowan Six Club Convention  : After Blackwood has been used a 5 NT is not available as it 
would be asking for kings.  Therefore the 6-clubs is used as a substitute for 
the Grand Slam Force.  The exception would be if the agreed upon suit were clubs.

           DOPI  : Is a countermeasure when your Blackwood slam is interfered with.  The letters give 
count of the aces present in your hand.  D = 0, P = 1. The next cheapest ace shows 2 aces and so on up 
the line.  The double may be left in for penalties or if your partner passes, you may double for 
penalties.
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Stop All Convention Alerts  :

If you check this menu item, then ‘Convention Alerts…’ will be disabled and none of 
the alerts will appear on screen.

    New Rubber:
      Will allow a new rubber to be started at any time during active play.

    Claim:

      This will bring up a dialog box that allows you to enter the total number of tricks that you are
claiming for the completed board. [Do NOT enter the number of remaining tricks you wish to claim.]
The computer does not check to see if this is correct.  You must be honest in your declaration.  This
feature  was  developed to simply speed up the  game when the  outcome of  the  game or  rubber  is
obvious.
Level  :

    Basic:
A Check Mark will indicate that this feature is active. 

See Default Settings in this manual for more detailed explanation of this selection. (see p. 5.)

   Intermediate:
A Check Mark will indicate that this feature is active. 

See Default Settings in this manual for more detailed explanation of this selection.  (see p. 6.)

   Advanced:

A Check Mark will indicate that this feature is active. 

See Default Settings in this manual for more detailed explanation of this selection.  (see p. 7.)

Help     Menu  :
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  About BridgePro:
Brings up the initial screen and copyright presentation.  Note: the version number for BridgePro™ 
is in the lower left hand corner of this dialog box.

LOOK HERE   

  Convention Card Example:
A scrolling example of a Convention Card that might be submitted during a duplicate bridge 
tournament. This is not an active screen.  You must set all your conventions from the Special Features 

menu ->Options >- Conventions.  See above.  

  Rules & Stuff:
A scrolling text that hits the highlights of this manual.

  BridgePro Home Page:
     Will automatically connect you via the internet to the BridgePro home page site.

  Download Manual:
    Will automatically connect you via the internet to view or download the manual in pdf format.

  Update To Latest Version:
     If you are connected on-line, clicking this menu item will take you directly to the web page that 
allows you to see if your version is current.  If not, you can proceed to download a new installer.

  Hints:
      Is always active.  This will give you suggestions for the next bid to make or the next card to 
play.  You may actually play the entire game by repeatedly pressing Ctr + Z.

Hidden Commands:   
If you wish to reverse AND flip the hands at the same time press Alt + F or H and the actions will be 

carried out simultaneously.

    You can open the Review Bid [Cmd Key + B] and Review Tricks [F1] windows using the  
Windows® default command key or F key, but you can also close the same window using the same 
command key sequence that you used to open them.
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Consult Manual Alert  :

Cue Bid of the Enemy’s Suit: This is the most common reason for the alert ‘Consult Manual’ (1d,
(1h),2d,(3d)).  This bid is forcing. If Michaels Cue bid is not played, the bid is forcing to game.

Jump Cue Bid: After the opponents open in a major, a jump cue bid of the opponent’s suit asks your 
partner to bid 3 NT if he has a stopper in that suit (1H,(3H),P,(3 NT),P,(P)). The overcaller has a solid 
minor with 8 or 9 guaranteed tricks, but lacks a stopper in the opponent’s suit.

Cue Bid Of Enemy’s Suit in Response To Partner’s Overcall: This represents a limit raise with 10 - 12 
HCP and at least 3 Card support of partner’s bid.

Transfer in the minors:  if the option box ‘Majors only’ is left unchecked, then 1NT:2NT = transfer to 
diamonds.  1NT:3c is natural with a slam going one-suiter.  1NT:2c does not guarantee the responder 
has a major (not Stayman).  He maybe using this bid to get to 2NT.

1NT:(Double):ReDouble - [The Great Escape]: The redoubler expects the opener to bid a puppet bid of 
2c.  He then will pass if his long suit is clubs or else he will bid his long suit.  The opener passes with 
3-card support or bids a higher suit in which 3+ cards are held.

2NT as Second Response to 2 Club Forcing Bid: This is a ‘double negative bid.’ The responder has less
the 3 or less HCP in his hand [2c,2d,2s,2NT].

Double over a 4H or 4S Pre-emptive Bid: Against a 4H opening, the double is for takeout and 
guarantees spade support.  Against 4S, the double is for penalties.

4NT over a minor Pre-emptive Bid of 4: This is a takeout bid [4d,(4NT)].

Response to Forcing 2c Doubled:  [2c,(Db),?] - bidding the enemy’s suit shows a balanced hand with 
positive values but no stopper in the suit shown by the double. A pass shows a weak hand with club 
tolerance and 2d shows weakness in clubs.

Gambling 3NT Bid: This shows a solid minor suit [AKQxxxx is minimum], 7 playing tricks and little 
else. If it is an overcall, there must be a stopper in the enemy’s suit.

Double in Defense against Transfer Bids: Initial double is lead directing.  Shows a strong holding of at 
least 5 cards and 3 or more honors in that suit.  If not playing Michaels Cue Bids, a double later is for 
takeout [1NT,(p),2H,(p),2S,(p),p,(Db)].

3NT Response to a Major Suit Opening:  [1s,3NT] - This is used when playing Limit Raises and not 
playing Jacoby 2NT Force Response.  It shows 4 card support for your partner’s major and 13+ HCP or
better.  Use the two-over-one response for your usual 3NT response.

Jump Bid After Blackwood: With 1 Ace [1 or 3 Key Cards with Roman Key Card Blackwood] and a 
void the responder bids six in his void suit provided it is lower ranking than the agreed suit.  If higher 
ranking, he jumps to 6 of the agreed suit.  With 2 Aces and a void, the responder bids 5NT over 4NT.

Blackwood Bidder’s call Other Than 5NT or the Agreed Suit: Whenever the response to Blackwood 
leaves the partnership short of enough aces to contract for the slam, the Blackwood bidder should bid a 
previously higher unbid suit. This asks the responder to correct to 5 NT which the Blackwood bidder 
passes making that the final contract. [1s,3c,4c,4NT,5d,5h,5Nt,p]

Unsual NT Bid:  If the bidding has gone p,(p),p,(1H), 1NT, then this last bid represents an unusual NT 
bid.
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2NT Overcall of a 1NT Opening: Game forcing bid showing a freak 2-suiter hand.  There must be at 
least a 5-5 distribution with 3 or less losers.  The suits are not required to be minors.

Support Double Pass Alert: When playing support doubles, if the bidding has been 1d,(p),1h,(1s),p this 
indicates that the opener has less than 3 card support for the major suit bid by his partner.

Lead Directing Double After Splinter Bid: If they are vulnerable and you are not, then the lead 
directing double of the splinter bid is used to show length and strength in the splinter suit and to 
suggest a sacrifice.  At any other vulnerability, the double asks for the lead of the lower ranking unbid 
suit.  Therefore, a pass would steer one’s partner to lead the higher of the unbid suits.

Redouble of Partner’s 1NT Opening [playing enemy defense of D.O.N.T. or Brozel] with minor 
transfer bids on: This indicates a transfer to clubs. (1NT,(Db),ReDbl)

Opening 5NT Bid: Shows a balanced hand which guarantees 11 tricks and asks responder to raise the 
bidding one level for each ace, king or queen he holds.

5 NT Bid:  With no agreed suit, this bid requests partner to “pick a slam.”  

Five Of a Major Opening: Shows a hand missing both top honors in the trump suit, but no other losers. 
Partner raises to the appropriate level if possessing either or both honors else passes.

Error In Logic Alert  :

   

 

 Sometimes memory becomes corrupted and the hand cannot be continued and sometimes BridgePro 
simply is perplexed and cannot solve the bidding or card play problem.  You may quit and restart the 
game to clear its memory or you simply may continue to another game.  However, might I suggest that 
you left mouse click on the BridgePro icon in the top left corner of the dialog box [see above Fig.].  
This will bring up the Save A Hand dialog box and you then can save this hand.  If you collect 6 of 
these non-playable hands and e-mail them to masK, LLC. [go to the BridgePro Home Page in the Help 
menu], you will become eligible for a free upgrade when a new version of BridgePro is published.  
Thank you for your help in making BridgePro a better game for all to play! 
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	See The Menu -> BridgePro -> RePlay Saved Hand.
	Using the Keyboard:
	Using the Keypad:
	Using the keypad is the fastest way to enter your bids!
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	Choose Scoring Method…: This will present a check menu with options for the default standard rubber scoring or Chicago type scoring [also available is New York type vulnerability.]. Rubber: Standard WE and THEY score with 2 consecutive game wins constituting a rubber or 3 total games. Chicago: A rubber consists of 4 deals. No one is vulnerable for first deal. For second and third deals, dealer is vulnerable and the other side is not. Both sides are vulnerable at the fourth deal. Part scores are combined. If a part score occurs at the last deal, then that side receives a premium of 100 points to complete the rubber. New York variation: The vulnerability of the second and third hands is reversed. This gives the non-vulnerable side an opportunity to preempt as dealer.
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	Tricks:
	
	Sound: A Check Mark will indicate that this feature is active. Various sounds have been selected for the BridgePro game. By disabling this menu selection, none will be played.
	Warning Beep: The game sounds a warning when it is your turn to input a bid or select a card..
	Quick Bid:

	Dummy Cursor Correction: On some monitors, the screen resolution and/or DPI cause abnormal interpretation of mouse clicks in the dummy cards. If you are experiencing difficulty clicking the proper card in the dummy try checking this option.
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	Reverse Drury:
	
	   Inverted Minor Suit Raise: This is a special response to a minor suit opening by your partner. If you have 10 points or less (include distribution) and support (4 or more of the opener’s bid), you respond with a jump to three of the minor suit. This is a weak shut out bid.

	
	Negative Doubles:
	New Minor Forcing:
	
	Splinter Bidding: 
	An unusual jump guarantees a fit for your partner’s last bid suit as well as game values with either a singleton or void in the suit bid. Splinters are used in both major and minor suits. Think of splinter bidding as a small slam try.[1s,4c]
	Support Doubles: A convention used by the opening bidder upon his rebid after the right hand opponent has overcalled. This double indicates 3-card support for the responder’s major suit. If the open passes, he must alert as this indicates less the 3-card support.
	Transfer Bidding: After a 1 or 2 level NT opening, the following responses are: 2d -> transfer to 2h 2h -> transfer to 2s 2s -> transfer to 3c 2nt -> transfer to 3d 3c is natural and a slam-going one suiter. If you have a quantitative 2nt raise, then bid 2c. This does not guarantee the responder has a major. He maybe is trying to reach 2nt. Therefore, some individuals use transfers in the majors only. [option check box: ‘majors only’]
	Pinpoint Astro: 2 Clubs  = Hearts and clubs ; 2 Diamonds = Hearts and diamonds; 2 Hearts = Hearts and spades; 2 Spades = Spades and a minor; 2 NT = Both minors.
	
	Brozel: Double show any one suiter worth a bid at the 2-level. Jumps to the 3-level show strong three
	 suiters, 4-4-4-1 or 5-4-4-0. 2c = Hearts and clubs 2d = Spades and diamonds 2h = Hearts and spades 2s = Spades and a minor 2nt = the minors
	Cappelletti [Hamilton, Pottage]: 2h or 2s = that suit + a minor 2d = Both majors 2c = One suited hand 2s = Spades and a minor 3-level = Natural All the hands usually have less than 15 HCP
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	BridgePro Home Page: Will automatically connect you via the internet to the BridgePro home page site.
	Download Manual: Will automatically connect you via the internet to view or download the manual in pdf format.


	Hints: Is always active. This will give you suggestions for the next bid to make or the next card to play. You may actually play the entire game by repeatedly pressing Ctr + Z.
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	Redouble of Partner’s 1NT Opening [playing enemy defense of D.O.N.T. or Brozel] with minor transfer bids on: This indicates a transfer to clubs. (1NT,(Db),ReDbl)
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